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Where&When Help!

The base screen for
Where&When provides
options that will aid you in
finding where and when to
communicate over long
distances.

The Main Menu

The main menu includes the

following pull down selections.
1. File

2. Tools
3. Help
File

Fle Took Hep
New [ Rename | Deiete Your Posison Recerver Position Parameter
Eowma e [i000S s poOON Fraquencies: [Mame.
s o Lon [oR0OW Lon [iiT00W 0 7em e [T ; owe [0222075 =]

6227
- I~ GPSOms o Sapet [ea

uTCome [3 =

GPS Offine Distance to Receiver:  NM

Under the “File” main menu option, only two possible selections

are available for Where&When, “Recalculation” and “Quit”.

Selecting the “Recalculation” option will result in Where&When to File | Tools Help

collect the data from any recent changes and complete a new | Recalculation |}_
calculation using the new information. This option is primarily Quit

applicable to user entered catalog frequency items when a change 22 Vianne |

to the frequency list is required. | 7 HAM Radio

Tools

By clicking on the “Tools” menu item there are three

possible selections.

1. View
2. GPS
3. Options
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Where&When Help!

Tools - View

When selecting the “View” option, the user may display or eliminate the Where&When status strip at

the bottom of the tool. The status strip identifies
the activity of Where&When with regard to a

connected “GPS:” and the “Distance to Receiver”.
The “Distance to Receiver” is based on the ﬁ
difference of Latitude and Longitude between the
user’s station and the station the user is hoping to

contact.

Tools - GPS

——
—

File | Extras | Help
Newl View » I Statusstrip -
(=) Defa GPS 4 E] Frequency-Catalog
W W, Lon: [114757W
;I ran=

Selecting the GPS will allow the user to connect ‘\Where&Wh_

of disconnect from a GPS that is connected to the
computer.

This function only defines if the GPS is connected
to Where&When and not if the data is being
used by Where&When.

Tools - Options

When the “Tools” “Options” is selected, Where&When
initiates a pop-up to allow the user to make further
adjustments to the program.

General Tab
Within the “General” popup, the user
may select the language of choice to

General | GPSMouse |

File | Tools | Help

New View > Your Pc

GPS » | Connect [

..... Options Disconnect ﬁ
o l[e27 T

B Where & When N
File

New View >

SO S b m
AT options T [anas

be used within Where&When, the Language:  [(Standard) -

“Propagation Timeout”, Source for W Load sun informations from the internet when startup

Solar flux Index (SFI), to allow I™ Allow more than one Instanz of \Where and When

multiple instances of What&Where I Use another time zone than the computer

to run, and if you would like to send IV Help ks imesove Whiere and Whaa and sand encr-hes sages anonymouely 1o Us
any error notices found back to the

development team to make Popagation-Teol ICEPAC] ¥

Where&When even better. Propagation-TimeOut: oc ms

The default of Where&When is to use
computer time. If you desire to use

another time zone than the default

you must put a check mark on “Use another time zone than the computer”.

On the General screen you may also select either VOCAP or ICEPAC for solar update information.
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Where&When RHelp!

GPSMouse Tab

A second tab is used to identify how the GPS receiver is connected to your computer.

The default mode of Where&When is to find the GPS automatically. When this option is selected, the
program will automatically search your communications inputs to look for GPS data coming into the

computer.

Lanius

General  GPSMouse |

[V Find the GPS-Mouse automatically

~Advanced settings
Portname v BaudRate: 9600
DataBits: 8 Parity: None v
StopBits One X ReadTimeOut: |500 ms

Handshake: |None v

¥ Allow GPS-input with warnings by the device.

L

the GPS position data.

If the GPS data is found, the data will be made available
for use within the Where&When program as the “Your
Position” input for the program.

If Where&When is unable to detect a connected GPS,
the default checkmark bay be removed by clicking on
the checkmark.

The user may now manually enter information about a
connected GPS to aid the Where&When in obtaining

“Portname” is the name of the communications port where your GPS is connected. By clicking on the

pull-down list for “Portname”, a list of the
available communications ports for the
computer will be listed.

Note: You may have to use windows
function “Devices and Printers” to determine
the communications name. e.g. COM1,
com, ... Com14 etc.

The configuration information within this
screen should match the information for the
communications port selected. The
“BaudRate” for most GPS outputs is 4800,

€ oo oo T

General GPSMouse |

I~ Find the GPS-Mouse automatically

— Advanced settings —
Portname coms) - BaudRate: l%mi
DataBits: [8—_ Parity: ,m
StopBits: One ¥l ReadTimeOut: [500  ms
Handshake: I—m

Reset I Connect | Disconnect

[V Allow GPS-input with warnings by the device.

however some do provide communications at 9600.

Help
Presently provides two options.

1. Support
2. Help File
3. About

@ Whereswhen
File Tools | Help

New | Renan Support
= Default Help File |
- Marine About
‘- HAM Radit
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Help - Support
When the user selects the “Support” option, the Where&When program provides a direct link to the

Where&When web site to get help.

I Where&When by YACHTFUNKCOM | +
L BB cccand-whenyachtfunk.con) ¢ ||®!- Yahoo AR

Radio |

1 \ﬁ Most Visited =. Email: p-t_on_sunysid... | | Weather | | SSWebs | _ Qak Harbor | Mexico | ) Navy | | Google

Where&When \\\\

WWW.YACHTFUNK.COM

IR Your Posttion
Oran Alg?evs : >
lorth 0 Lat: 28'22N
lantic A
cean Cassplence Lon: 016'28W

S
MOI’OCCOV-" ,J GPS Data

5 o o
el Algeria . 1557y

Westemn X Lon: 022'45W
Sahara

Help- Help File
Help file calls up this help information file.

Help - About

When “About” is selected, the present version and other product and support information is displayed.

@About - yachtfunk.com

WW. YACHTFUNK.COM

IHR KOMPETENTER PARTNER RUND UM KOMMUNIKATION AN BORD

About

Where & When

is a HF-Propagation Radio Tool. based of ICEPAC by
ITS. ltwas developed 2013 by YACHTFUNK.COM.

VERSION: 1.0.1.3

USER
BFESFEFF000106
SERIAL# CR ooanancra. - - F2GDX9 - SMTWBE

|
[
|
4 ® YACHTFUNK COM
|
l
|

Jorg Drexhagen

Am Rickfeld 9 Telefon: +49 (0)5241 998 55 35
33332 Gutersloh Mobil: +49 (0)171 345 70 70
Germany Emal hag

Programmed by Philip Strat
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Frequency-Catalog

A secondary list of tasks is included under the main menu items.

1. New
2. Rename
3. Delete

These tasks are used to modify the catalog list on the left side of the display. Pressing “New” allows the
user to create a new entry in the catalog tree. A list of frequencies to be considered by the calculation
engine will be possible. Some cruisers add weather fax stations of interest as well as email options they
are planning to use.

When the pre-loaded “Default” category tree names are selected (Ham and Marine), the Rename and
Delete functions are grayed out and may not be changed to eliminate accidental removal of basic
communications frequencies for Cruisers.

Create a new Category and Frequency List

1. To create a new Catalog entry, use the mouse to click on “New”.

A “1” will be added to the Menu Tree under the “User” section of the tree.
Click on the “1”

Click on “Rename” above the catalog.

vk wnN

Type in a name for the frequencies you will be adding.

a. When the new frequency spectrum is added, the information will be added in a “User”
section tree allowing the “Default” selection tree to remain as per the initial software
was defined.

6. The frequency list column (the next column to the right) will now be blank.
7. Click on the white bar and type your first Frequency for this category in the white bar space.
8. To add another frequency, click on the white bar below the frequency just entered with your
mouse, press down arrow or press “Enter” and type in the next frequency.
a. A maximum of 11 frequencies may be added for any one user defined category
9. Repeat step 8 above until all the frequencies desired are entered. The information is

automatically saved.
The user may select one of the user defined frequencies and change it to a new frequency by selecting

the frequency row with the mouse and typing in the new frequency. To cause Where&When to
provide a new calculation with the new frequency in the table, select “File” and then “Recalculate”.
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Manually Changing the Position

If there is a GPS connected to the computer and the box “GPS Data” has a check mark in the box, “Your
Position” will automatically be updated. If you would like to enter “Your Position” and/or the
“Receiver Position” the data within the latitude and longitude must be cleared first.

To remove Latitude and Longitude data, wipe the Latitude or longitude with your

Lat; |[maein
mouse and press delete. When the field is blank it will display: ___ ° ' . To
enter the new position, click on the left most side of the field and type in the Lon: [10522W
numbers corresponding to the Degrees then Minutes and then N, S, E W for North,
South, East, or West respectively for the entered latitude or longitude. —
Lat: |L'__

Lon: |105°22°W

Parameter

Within the Parameter section of the display, information to improve the calculation and how it is
displayed can be modified by the user.

Parameter

Frequencies: Frequencies: |Marine

May not be modified in this section as it is

only defining what Catalog set of SFI: ‘16’ Date: | 2/14/2014 ~ ]

frequencies have been selected. Sunspot [121 UTC offset [0 =]

SFl: Sunspot:
The user may enter either the Solar Flux Index (SFI:) or the “Sunspot:” number and Where&When will
calculate the best fit for the other parameter.

Update:

When connected to the internet, pressing the update button will go to either ICEPAC or VOCAP,
depending on what was selected in the Tools - Options pull down. Hovering over the button will result
in the present data information. Sun spot data can change the propagation so be sure and update
before you leave port for the best propagation calculations.

Date:

The date option allows the user to check the propagation for other days and allow communicators to
plan communications sessions. Clicking on the pull down window the user may select the date from a
calendar input screen.
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Where&When Help!

UTC offset:

The UTC offset allows the user to change the display from Universal Time to local time. To modify the
display for local time, click on the up arrow for positive changes to universal time and the down arrow
for negative changes to universal time. E.g For local time to be displayed on the west coast of the
United States, PST, user would select: “-8”.

Using the Map Function
R 4
Pressing the “Map” button on the ot o il
display below the “Receiver < L
Position” will display a map of the (hggr™ | mCe e [
world. -

On the right side of the map the
present latitude and longitude for
both “Your Position” and the
“Receiver Position” will be

displayed.

If the “GPS Data” is not selected, the data will be static and not change.

Located on the map you will also find a green balloon and a red balloon with a black dot. The balloons
correspond to “Your Position” and the “Receiver Position” respectively.

Either balloon may be moved with the mouse to identify the “Your Position” and the “Receiver
Position”.

The world map may be difficult to define an actual location. When&Where allows the user to zoom
into locations using the scroll key on the mouse.

The user may zoom in and out on a
When&Where map by using the
Scroll key on the mouse.




Where&When Help!

Continued rotation of the scroll

| S|

key will further zoom into a map

Las Cruces

Tucson s
. . R [~ Your Position
location. Reversing the Peree | Lo JaTaTN
direction the scroll key is moved | ~ Lo [TEW N
. Cahgrca :;

will zoom out. Lo

[~ Receiver Position——

Lat: |24°07N
When zoomed in sufficiently the \ 1 # Hermosillo | on: [iT0TaW
map will show the location of 5 . ) cuwhiemoc OCHY

Guaymas \
9 Ciudad L
Obregon N

o \
Raavi- Navojoa- ¢
) X\

“Your Position” and the
“Receiver Position”. In the :
example below the positions =

“ Losl‘ Ij‘laobhis A \\. I

are set for Ensenada, “Your e, [0
Position”, and La Paz, “Receiver ‘ C“'jSCF'»‘\”
S o 1\ 7

Position”, Mexico.

‘ saglak*
When the balloons are placed at a new location, as shown for the new “Your Position” and “Receiver
Position” locations, When&Where automatically updates the map screen positions and the calculation
screen positions. Where&When performs it’s new calculation based on the difference in the balloon
locations.

What Frequency to use?

When you are looking atthe v, pesition——— - Receiver Position et
display to determine which Lat  [10°00 Lat: [20°00N Frequencies: [Marine
frequency to use, you will see Lon: [080°00W Lon: [110°00W 10.7cm-Fhux: [113 el [10/2272015_~]
black time bars around the I~ GPS Data Map | Sunspot:  [64 Hncele UTC offset: |2 =
local time. The time marked Frea | 00] 01] 02] 07| 04)\05] 06 07] 08] 03] 10] 11] 12| 13| 14| 15] 16] 17| 18] 19720] 21
by the black time bars is % 2 SO| 551 561 55 55| 59} 62 (8
always based on computer 6227
time. e <X :
12356 | 58/ 62/ 70 65 54 66 45 55
If another ti . 16531
another time zone is s
selected, such as UTC, the 2162
25103

time scale numbers, the top
row of numbers, are now

based on the selected time
zone. However, the time bars will remain an indication of local computer time. To deter the
propagation, you must now look under the appropriate UTS time. Do not use the local time bar
propagation when other time zones are selected.
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